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In tandem with our new mobile application. This means you now have more flexibility in the field,
and can now leave your office knowing that yourForget to charge your printer. No problem! The
SML200 is rechargeable via any 5V USB connection! This case comes with a lifetime warranty from
the manufacturer, Underwater Kinetics. It is our goal to provide products and services that are more
than satisfactory for our customers. If you arent happy, we arent happy. Dont be FOOLED by cheap
Chinese knockoff paper, which sell for quite less, and may contain toxic chemicals. Here we only
carry American made paper rolls. At Terminaldepot you will receive.Dont be FOOLED by cheap
Chinese knockoff paper, which sell for quite less, and may contain toxic chemicals. Here we only
carry American made paper rolls. At Terminaldepot you will receive nothing.Dont be FOOLED by
cheap Chinese knockoff paper, which sell for quite less, and may contain toxic chemicals. Here we
only carry American made paper rolls. At Terminaldepot you will receive nothing.Dont be FOOLED
by cheap Chinese knockoff paper, which sell for quite less, and may contain toxic chemicals. Here
we only carry American made paper rolls. At Terminaldepot you will receive nothing.Dont be
FOOLED by cheap Chinese knockoff paper, which sell for quite less, and may contain toxic
chemicals. Here we only carry American made paper rolls. At Terminaldepot you will receive
nothing.Dont be FOOLED by cheap Chinese knockoff paper, which sell for quite less, and may
contain toxic chemicals. Here we only carry American made paper rolls. At Terminaldepot you will
receive nothing.Dont be FOOLED by cheap Chinese knockoff paper, which sell for quite less, and
may contain toxic chemicals. Here we only carry American made paper rolls. At Terminaldepot you
will receive.Dont be FOOLED by cheap Chinese knockoff paper, which sell for quite less, and may
contain toxic chemicals. Here we only carry American made paper
rolls.http://giwajib.com/data/editor/compression-testing-machine-manual.xml
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At Terminaldepot you will receive.Here at Terminaldepot you will receive nothing but the best, and
finest quality paper for your mobile terminal.Dont be FOOLED by cheap Chinese knockoff paper,
which sell for quite less, and may contain toxic chemicals. Here we only carry American made paper
rolls. At Terminaldepot you will receive nothing.Dont be FOOLED by cheap Chinese knockoff paper,
which sell for quite less, and may contain toxic chemicals. Here we only carry American made paper
rolls. At Terminaldepot you will receive nothing.Dont be FOOLED by cheap Chinese knockoff paper,
which sell for quite less, and may contain toxic chemicals. Here we only carry American made paper
rolls. At Terminaldepot you will receive nothing. Due to a unique patented electrometer and open
grid probe design, the MODEL CRM510LP is highly suited for a wide range of radon measurement
applications. Because of the low current requirements of the electrometer detector and onboard
computer, the MODEL CRM510LP is truly a portable selfcontained continuous radon monitor that
can read and store test data for eight days of standalone operation. The full function computer
system incorporated in the MODEL CRM510LP provides the operator with a highly flexible radon
detection instrument and data logger operating system, while still maintaining the simplicity of
operation for which femto TECH instruments are noted. In addition to the measurement and storage
of radon data, the highly sophisticated onchip peripheral capabilities of the microcomputer MCU
used in the CRM510LP provide for the measurement and storage of temperature, barometric
pressure, and relative humidity. This multidimensional data acquisition capability provides the tester
with a unique data base for evaluating the validity of short term radon measurements. It is further
recommended that the user perform practice tests to become familiar with the CRM510LP before
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carrying out actual field tests. 4.http://oneworldland.com/userfiles/compressor-3-manual.xml

2 CONTROLS Operating the CRM510LP is simplicity itself. Because the CRM510LP operates on only
microamperes of current, the electrometer detector operates continuously obviating the need for a
warmup period. All other functions are controlled by the internal microcomputer MCU. The
functions of the CRM510LP front panel controls are described below. Power to the MCU remains on
at all times. The display will be turned off if a button is not selected in a reasonable time to conserve
power. CRM510LP Continuous Radon Monitor is a complete data acquisition system based on an
internal microcomputer MCU. All operator interaction is accomplished via easy to follow LCD screen
prompted selections and pushbutton entered commands. Nearly all the features of the data logger
program can be used immediately without extensive operator training because responses are
prompted by screen menus. The operating system and fixed parameters are stored in EPROM
Erasable programmable read only memory. Whereas instrument settings which seldom need
changing such as units, calibration factor, background value, and serial number are stored in an
EEPROM Electrically erasable programmable read only memory. In the RUN MODE the MCU reads
and stores data from builtin radon and environmental sensors and displays current readings of these
parameters on the LCD screen. The selection of units for screen display remains in effect during the
total data collection period. The units selected at the start of the test will be retained as the default
during output. Up to 8 days 192 hours of accumulated hourly count interval data are stored. In the
event of a system failure for any reason during a test, all data collected prior to the failure point will
be retained. Moreover, the CRM510LP will continue to operate and recalculate even after the data
storage memory is full. This data may only be displayed as long as the test is running. It is NOT
available if the test is terminated See section 4.3.

4 digital combination screen lock. For tamperresistant security during a test, a key lock switch is
provided. Screen security is also provided whereby only elapsed time can be viewed without
entering a digital unlock code. Computation Algorithm To fully utilize all the functions of the
CRM510LP, an understanding of some of the features of the computational algorithm is helpful. The
elapsed time and total accumulated count data are collected, stored, displayed, and printed directly
in units of minutes and counts, respectively. However, the present concentration data are computed
using an algorithm based on a digital model of a rate meter. Due to the above features, present
concentration data will not reach a stable value for approximately one hour after initial startup.
However, the accumulated average concentration data are computed and updated at onetenth
minute intervals and are immediately valid within the counting statistical constrains of the radon
level being measured. The background value used in this computation is stored in EEPROM and can
only be changed by procedures described in Appendix F. Operation 1. Turn the CRM510LP
keyswitch to the RUN position. The screen will temporarily display RUN. The units used in the
previous test will then be displayed on the LCD screen. The display will show SELF TEST ACTIVE 6.
If successful, the screen will display PASSED SELF TEST TEST STARTED. If, however, the screen
displays FAILED SELF TEST then goes blank, repeat the test initiation procedure. If the unit fails
three straight self tests, contact femto TECH for technical assistance at 937 7464427. At the end of
this six minute period, the screen locks to a blank display and the tilt transducer is activated and
remains active until the end of the test. The tilt transducer is designed for fixed position tests with
the CRM510LP in a level position. 8.

http://dev.pb-adcon.de/node/18200

After the first six minutes of a test, a digital code must be entered to unlock the screen for viewing
the parameters other than elapsed time See DIGITAL COMBINATION SCREEN LOCK SECTION
4.3.4 for details. 9. The CRM510LP will continue to collect data until the test is terminated by the
exit procedure below. The accumulated data will be retained as long as a new test is not initiated.
However, when a new test is initiated, the previous data are cleared. The unit must have no test less
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than 1 hour of data in its memory. As soon as the screen displays TIME 0 min The screen will display
No Data to Print Turn the key to the RUN position. After the correct time is displayed, immediately
turn the keyswitch to OFF to store the time. 4.3.4 DIGITAL COMBINATION SCREEN LOCK
Description A builtin screen security feature prevents unauthorized personnel from access to test
parameters and results. If the correct code has been entered, the count data display will come up on
the screen. At this point, USE ALL DATA will the display on the screen. This will display SKIP 1ST 12
HOURS on the LCD screen, and the computer will recalculate the test, eliminating the first twelve
hours from calculations. Keep in mind that the US EPA protocol test must have a minimum of 44
hours of contiguous data. All hours of data will be printed but the first twelve hours will have three
asterisks printed in the hour column to signify that those hours values were not used in the average
radon concentration calculation. The last test is retained memory until a new test is started. Test
circuitry is built into the CRM510LP to provide the operator with information on the charge level of
both battery systems. If the remaining charge in the microcomputer battery drops below that needed
to sustain a 48 hour test, the unit will not allow a test to begin. A test in progress is not jeopardized
and may be continued for up to 48 hours.

However, the computer will not allow a test to be initiated from the RUN key switch position and
displays a LOW BATTERY message on the LCD screen, if a test is attempted with less than 48 hours
of battery power supply available. The status of the electrometer battery system is also checked by
the microcomputer. If the charge on the electrometer battery drops to a point where the operation
of the radon detector could be effected, the computer in the CRM510LP will not allow a radon test to
begin. If a radon test is attempted from the RUN key switch position, a LOW BATTERY message is
displayed on the LCD screen and test startup is inhibited. If the computer detects a low electrometer
battery condition during a test, a low battery flag is set in the collected data and the condition
indicated in the printed test summary. The various battery voltages will then briefly display. These
sensors have been incorporated to measure parameters that may effect the interpretation of short
term radon analyses. The variation of these parameters during a radon analysis provides information
that can be used to judge whether a test may have been compromised by environmental conditions
or occupant interference. Although the span and scale settings for these sensors are adjusted during
manufacturing to agree with precision laboratory instruments, their measurement data should be
used as qualitative time varying information only. The MCU reads and processes the information
from the environmental sensors every six minutes and saves their hourly averages along with the
hourly radon readings. 4.4.1 TEMPERATURE Temperature is measured with a thermistor transducer
situated inside the CRM510LP cabinet. The CRM510LP MCU digitizes and processes the analog
signal from the temperature transducer for display and storage in units of F or C. 4.4.2
BAROMETRIC PRESSURE The barometric pressure is measured with a differential pressure
transducer referenced to vacuum.

The pressure measured by the CRM510LP is the actual atmospheric pressure at the test location
station pressure. If required, the CRM510LP MCU can be programmed to apply a MSL adjustment to
the pressure measurements See APPENDIX F. 4.4.3 RELATIVE HUMIDITY Relative humidity is
measured with a capacitance transducer situated inside the CRM510LP cabinet. The CRM510
computer digitizes and processes the analog signals from the capacitance transducer for display and
storage in units of percent relative humidity. 4.5 RS232C INTERFACE The CRM510LP has a builtin
RS232C serial port for interfacing with computers, modems, and other peripheral devices. The key
switch should be in the OFF position when making connections to the RS232C plug. The serial data
output is from pin 22 on the rear 25 pin connector since this connector also provides a simplified
Centronics parallel output. Thus, standard 25 pin to 9 pin cables available at the computer parts
store will not work. A custom cable is required. Contact femto TECH for answers on the use of the
RS232C interface or see Appendix F for details. 4.6 PARALLEL PRINTER INTERFACE The



CRM510LP also contains an 8 bit simplified Centronics Registered trademark of Centronics
Corporation interface on the same DB25 connector on the back panel. This is useful for connecting
to a variety of low cost printers. This also may require a custom cable. See Appendix F for details of
the connector. The data printed for the TABLE may work on some printers since it only contains
printable ASCII characters with each line terminated with a carriage return. 5. RADON
MONITORING 5.1 METHOD The femto TECH CRM510LP is a continuous radon monitor CRM
employing passive diffusion sampling of the ambient air environment in which it is situated. Radon
decay products are electrostatically removed and prevented from entering the internal pulsed ion
sensing volume. In addition to the general protocol documentation referenced above, femto TECH,
INC.

Additions and revisions to this document or new documents pertinent to the application of the
CRM510LP RADON MONITOR will be available to registered owners as they are published. 6.
MAINTENANCE 6.1 CALIBRATION The factor relating counts per unit time and radon concentration
is a consequence of the structural and electronic design of the CRM510LP and only small variations
between different production units have been observed. If a user application demands greater
accuracy, direct calibration of the unit at a radon chamber facility is required. To insure continued
confidence in the accuracy of your instrument, it is recommended that a calibration be performed at
least once a year or according to state or national standards as required. Therefore, environmental
gamma radiation or intrinsic ions are not sources of background as with most other types of
detectors. However, progeny plateout on the detector surfaces can result in a slow buildup of an
alpha radiation background from Polonium210. A background determination can be performed by
placing the CRM510LP in an air tight enclosure or plastic bag. Flow the background gas through the
enclosure or bag for at least six hours. Please contact femto TECH for battery replacement. 7.
WARRANTY Femto TECH, INC.This warranty is limited to repair or replacement at femto TECHs
option. Buyer assumes responsibility to apply femto TECH, INC.Femto TECH, INC. recognizes no
other warranty policy than this policy as stated. 8. REPAIR POLICY If this unit becomes defective
due to workmanship or materials at any time within one year of purchase, return this unit to the
distributor or dealer from whom the unit was purchased along with proof of purchase Sales slip,
invoice, or receiving slip copy, for repair or replacement.

If the unit becomes defective beyond the one year warranty period, or was damaged due to physical
abuse or attempts to operate the unit beyond its environmental specification limits, warranty repair
or replacement does not apply. However, femto TECH, INC.APPENDIX A OPTIONAL DPU201G
THERMAL PRINTER OPERATION Before using the Seiko DPU201G printer with the femto TECH
MODEL CRM510LP radon monitor, it is recommended that you read pages 1 through 12 of the
DPU201G INSTRUCTION MANUAL. Once you are familiar with the operation of the printer, turn off
both the DPU201G and the CRM510LP, and connect the two components using the cable supplied
with the DPU201G printer option. The FEMALE DB25 end of the cable should be connected to the
output port on the CRM510LP and the MALE 14 pin end to the parallel input port on the DPU201G.
The display should read Software Rev XXX if the test had previously stopped, or TEST ENDED.The
unit, in either situation, is now ready to print out. The number of minutes of stored data is displayed
on the LCD screen. If open house conditions were encountered at the start of the test, the user has
the option of not using the first twelve hours of the test data in the calculation of the average radon
concentration. The first twelve hours of the test will be printed, but will be marked by triple
asterisks instead of hours, and are NOT used for the calculation of the final average at the bottom of
the printout. 8. At the conclusion of a printout, turn off the power on the printer, and turn the
CRM510LP key switch to the OFF position, before disconnecting the printer. FIGURE 1. EXAMPLE
CRM510LP RADON TEST REPORTS Examples of both TABLE and GRAPH format versions of radon
test reports from a 48 hour measurement with a CRM510LP are presented in Fig. 1. In both formats
a header is printed with lines for test information to be entered by the operator.



The instrument serial number, calibration factor, and background are also printed in the report
headers and test summaries of total time, total counts, and average concentration are printed at the
end of both report formats. In the TABLE format seven columns of hourly data are printed for the
radon concentration, the tilt status, the low battery warning, the relative humidity, the atmospheric
pressure, and the temperature. The asterisk in line 48 is an example of a low electrometer battery
warning in a test report. The same 48 hour data set printed in GRAPH format is shown on the right
in Fig. 1. The plot is scaled to provide maximum resolution for each of the plotted parameters. The
scale values and a plot key for each of the parameters are printed in the header along the horizontal
axis of the graph. APPENDIX B OPTIONAL DPUH245 THERMAL PRINTER OPERATION Print
operation for the DPUH?245 Printer is the same as the DPU201G. However, the DPUH245 does have
the ability to run on either battery power or AC power, whereas the DPU201G does not have true AC
operation; it simply runs on battery power as it is being charged. Special instructions for DPU245H
charging, battery and AC operations are 1. The printer will not operate while in CHARGE mode. If
the printer battery is low, the AC adaptor may be used as a power supply instead of a battery
charger by simply plugging the adaptor into the printer and a wall outlet. 2. To use the adaptor as a
battery pack charger, hook up the adaptor between the printer and a wall outlet. This printer and
adaptor have different voltages and polarities than other femtoTECH items. Any attempt to use an
adaptor from the CRM510LP or any other femtoTECH components will damage this printer, and its
adaptor will damage all other femto TECH instruments and printers.

APPENDIX C femto TECH DOWNLOAD SOFTWARE This section provides system requirements,
instructions to install this program, a quick description of what it does and quick instructions on how
to use the software to retrieve data from a unit. This section can also be found as the ReadMe.txt file
on the download software CD. System Requirements This program should install to any Win95
computer or greater with at least 10MB of hard drive space. To communicate with a femto TECH
radon monitor you will need an available COM port with the port number in the range of 1 to 4 and
the serial cable provided with the unit. Directions for Software Installation Insert the femto TECH
download software CD into your computer CDROM drive and the setup program should run
automatically. If it does not run automatically, use your file browser and surf to the CDROM drive
that the femto TECH download software is in and double click the setup.exe file. The setup.exe
installation program will guide you through the rest of the process. After completing the install
process, choose your system settings before trying to retrieve any data from a femto TECH radon
monitor. To do this, start the program and click the View menu option and then the System Settings
option. Program Operations The primary purpose of this program is to retrieve data from a femto
TECH radon monitor, store the data to your computer, and generate reports for both the technician
and the customer. This program also allows the user to regenerate a report using the stored data
retrieved from a femto TECH radon monitor. Each time new data is retrieved from a femto TECH
radon monitor, three files are created. The first file is the raw data from the unit stored in a.raw file.
The second file is the technician report stored in a.tech file. And the third file is the customer report
stored in either a.txt or.doc file depending on which file format you choose in System Settings.

There is an example of each of the files created in the \Reports directory under the directory the
application was stored in. All files, except.doc files viewed by Microsoft Word, can be viewed from a
simple text editor such as NotePad.exe. The files are designed to be viewed with courier size 10 font.
Using the Program 1. Start Program To start the program, navigate to the program icon in your start
menu and click it. 2. Change System Settings To see or change your system settings, click the View
menu option and then click System Settings. Edit the window as needed and click Save to store the
data. 3. Receive Data To retrieve data from a femto TECH radon monitor, click the File menu option
and then click Receive Data.. The program will step you through the process. 4. Regenerate Data To
regenerate existing data, click the File menu and then click Regenerate Report.. The program will
step you through the process. To access this information, Click the Help menu option and then click



the About option. APPENDIX D OPTIONAL CARBON MONOXIDE DETECTION The femto TECH
CRM510LP can include an internal a carbon monoxide sensor. The data output provides a selection
of either the RADON REPORT or the CO REPORT in either TABLE or GRAPH mode on a DPU201G
or H245. Radon and CO levels can be obtained by printing both reports data for radon and CO are
retained until a new test is initiated. The RADON REPORT graphs radon, barometric pressure and
temperature while the CO REPORT graphs CO, barometric pressure and temperature. Humidity
results are only available using the TABLE output of the reports. A summary of the duration in
minutes of the test and the average of the radon or carbon monoxide for the test period is provided
at the bottom of the report. Proceed the step 4, Appendix A. APPENDIX E OPTIONAL MODEM
OPERATION The CRM510LP can be purchased with software and hardware that provide for
uploading data files to a host computer via a telecommunications link.

All software and hardware required for the upload side of the link is furnished with the femto TECH,
INC. However, femto TECH, INC.The CRM510LP modem driver routines use standard AT command
codes and recognize numerical result codes from the modem. Prompting and response messages are
displayed on the CRM510LP LCD screen at each stage of the communication. If the modem and
connecting cable were purchased from femto TECH, INC., two simple connections to the CRM510LP
and the phone line are all that you will need to perform a file upload. The modem must be connected
to a private line and should not be connected to a party, call waiting, or coinoperated telephone line.
Also the MODEM MODE jumpers described in APPENDIX F must be installed on the CRM510LP side
of the cable connector. It is recommended that only individuals with experience in this type of
communication hardware attempt to interface a user supplied modem to the CRM510LP. Moreover,
modem manufacturers take certain liberties with the AT and RS232C conventions which could make
it difficult to establish a reliable interface for this application. Operation With the keyswitch in the
OFF position, make the interface connection between the CRM510LP and the modem. Insert the
modems telephone cable into a telephone outlet. Once the hardware connections have been made, a
file transfer is performed following the procedure described below. Turn off the CRM510LP, check
all hardware connections and restart the upload sequence. Note 4. The blinking cursor will progress
through the digits as the number is dialed. If the HOST computer telephone line is busy, a BUSY
message will be displayed. If a connection can not be successfully made after several tries, check
with the host computer operator to determine whether the receive hardware and software are
operating properly.

Although, the user is required to furnish this portion of the telecommunications link, a description of
a simple workable system is presented as a guide for the user to develop a custom system. The
system described below is based on a commercially available communications software program
ProComm Plus 1.1B by Datastorm Technologies, Inc. running on an IBM type PC. The
communications software must perform the following tasks 1. Auto answer on ring, 2. Connect
online at 2400 baud, 3. Interpret password sent from CRM510LP, 4. Transmit a readytoreceive file
code to the CRM510LP, 5. Receive ASCII file transmitted from CRM510LP, 6. Store received file, 7.
Send filereceived code to the CRM510LP, and 8. Go on hook and wait for next call. At the completion
of the download sequence, a compiled BASIC program is called to format and save the data set in an
ASCII file that can be easily transported to a data base, a spread sheet, a word processor, or another
program specific to the reporting and record keeping needs of the user. The required handshake
protocols can best be understood by examining the example programs listed below. APPENDIX F
SPECIAL FEATURES The CRM510LP has special features and capabilities that can be utilized by
advanced users. An OFF logic state is set by connecting the particular pin to the ground pin 16. The
computer reads these control code lines on power up and enters the operating mode designated by
the setting. Abstract This integration is a part of Siebel Integrations between. User Manual Due to
continuous improvement, actual product may different. Manual and cnc vertical mill, manual lathe,
manual and cnc plasma. Add Data Manual The following manual describes how to add Companies,. 1



How to Use This Manual The following miniguide will help you efficiently. Manual 5 Rules,
regulations, instructions, manual and records for discharging functions at Manual is updated as
required; Suppliers are expected to comply with.

DPUH245 Seiko Instruments recommended Printer Cable optional You need to coordinate the baud
rate and data transmission conditions on both Main Body and the printer. The factory setting of
Main Body is as follows. Direct thermal pr Page 4 and 5 Low Voltage Low 24Volt Voltage Seri Page 6
and 7 Low Voltage Low 24Volt Voltage Seri Page 8 and 9 Low Voltage Low 24Volt Voltage Seri Page
10 and 11 Low Voltage Low 24Volt Voltage Seri Page 12 and 13 Low Voltage Low 24Volt Voltage
Seri Page 14 and 15 Low Voltage Low 24Volt Voltage Seri Page 16 and 17 Low Voltage Low 24Volt
Voltage Seri Page 18 and 19 Low Voltage 24Volt Mobile Printer S Page 20 and 21 Low Voltage
24Volt Mobile Printer S Page 22 and 23 Low Voltage Low 24Volt Voltage Seri Page 24 and 25 Low
Voltage Low 24Volt Voltage Seri Page 27 and 28 Low Voltage 24Volt Mobile Printer S Page 29 and
30 Thermal Printer Subassembled print Page 31 and 32 Low Voltage 24Volt Serial Printer M Thank
you, for helping us keep this platform clean. The editors will have a look at it as soon as possible.
Flowmeters Dial InLine Orifice Plate Totalizing Ultrasonic Variable Area With Switch Output With
Transmitter Output Level Bin Vibrators Level Indicators Level Switches Level Transmitters Pump
Controllers and. Please check your inbox, and if you can’t find it, check your spam folder to make
sure it didnt end up there. Please also check your spam folder. The subject of each caution is
illustrated inside the triangle e.g., high temperature caution symbol shown on the left. Do not take a
prohibited action shown inside or near this symbol e.g., disassemble prohibiting symbol shown on
the left. A specific action is given near the symbol. Use soft dry cloth to remove stains. Do not leave
spent batteries in the battery compartment. Operating hours by battery power are only ensured
when using the supplied NiMH batteries. It is recommended that sampling is performed without
using the tube.
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